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Preface

Preface

This preface contains the following sections:

e Documentation accessibility
e Diversity and Inclusion

* Related resources

e Access to Oracle Support

e Additional copyright information

Documentation accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility
Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Diversity and Inclusion

Oracle is fully committed to diversity and inclusion. Oracle respects and values having a
diverse workforce that increases thought leadership and innovation. As part of our initiative to
build a more inclusive culture that positively impacts our employees, customers, and partners,
we are working to remove insensitive terms from our products and documentation. We are also
mindful of the necessity to maintain compatibility with our customers' existing technologies and
the need to ensure continuity of service as Oracle's offerings and industry standards evolve.
Because of these technical constraints, our effort to remove insensitive terms is ongoing and
will take time and external cooperation.

Related resources

All documentation and other supporting materials are available on the Oracle Help Center.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through
Oracle Support Cloud.

Contact our Oracle Customer Support Services team by logging requests in one of the
following locations:

* English interface Customer Support Portal (https://hsgbu.custhelp.com/)
e Japanese interface Customer Support Portal (https://hsgbu-jp.custhelp.com/)

You can also call our 24x7 help desk. For information, visit https://www.oracle.com/life-
sciences/support/ or visit https://www.oracle.com/corporate/accessibility/learning-
support.html#support-tab if you are hearing impaired.
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Additional copyright information
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This documentation is for internal-use only.

This documentation may include references to materials, offerings, or products that were
previously offered by Phase Forward Inc. Certain materials, offerings, services, or products
may no longer be offered or provided. Oracle and its affiliates cannot be held responsible for
any such references should they appear in the text provided.



Basics

In this chapter

e How do | find information about my study?

e How do | change my password?

e How do | reset a forgotten or expired password?

e How do I log out of a study?

How do | find information about my study?

ORACLE

Table 1-1 What to do, where to go, how to get there

What do you want to know?

Where to go

How to get there

Where am | after | log in?

You're on the Home page, which
you can configure to display the
information that you need for your
study.

Log in.

How can | see the queries that |
need to work with?

*  Queries page
» Data Viewer Summary view

Click Queries.
Or
Click Review.

There is a high number of open
gueries at one of my sites. How
can | see which forms have open
queries?

Data Viewer Record Listing view

1. Click Review.

2. Optionally, at the top left
corner of the Data Viewer,
click Summary > Sites to
sort data by site.

3. Inthe Forms with Queries
column section, in the
Opened column, click the
cell in the site's row.

4. Atthe top of the Data Viewer,
click Go to Record Listings.

How can | see the forms that |
need to freeze or lock?

Data Viewer Record Listing view

Click Review.

How can | see the data that |
need to source verify?

*  Source Verification Listing
page
» Data Viewer Summary view

Click Monitor.
Or
Click Review.

How can | override the default
system settings for Partial SV for
my sites?

Set SV Settings dialog box

1. Click Monitor.
2. Click Set SV Settings.

3. Inthe upper-right corner,
select a site.
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How do | find information about my study?

Table 1-1 (Cont.) What to do, where to go, how to get there

What do you want to know? Where to go

How to get there

How can | see a summarized
status of operational data, such
as queries, form states,
verification states, and custom
review states (if defined) for my
study?

Data Viewer Summary view

1. Click Review.

2. Optionally, at the top left
corner of the Data Viewer,
click Sites to sort data by
site, rather than by visit.

I noticed an anomaly in some
clinical data. How can | see more
details?

Data Viewer Record Listing view

1. Click Review.

2. Optionally, at the top left
corner of the Data Viewer,
click Summary > Sites to
sort data by site.

3. Click the cell with the data
you want to investigate.

4. Atthe top of the Data Viewer,
click Go to Record Listings.

How many items in my study are Data Viewer Comments view

marked incomplete, and why?

1. Click Review.

2. Atthe top left, click
Reporting > Comments.

How can | compare clinical data
such as Adverse Events for two
subjects?

Data Viewer Record Comparison
view

1. Click Review.

2. Select a cell for data on a
form you want to compare.

3. Click Go to Record
Listings.

4. On the left, under Forms,
select a form.

5. At the top of the Data Viewer,
from the Open Comparison

View drop-down list (@)
select a form that you want to

compare the selected form
to.

How can | run reports for my Data Viewer
study? or

Reporting and Analysis module

Data Viewer:
1. Click Review.

2. Atthe top left, click
Summary, and then an
option.

3. Click Reporting, and then an
option.

Reporting and Analysis module:
*  Click Reports.

How can | move my site to a new Deployment page
study version?

Click Deployment.
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How do I change my password?

Table 1-1 (Cont.) What to do, where to go, how to get there

What do you want to know? Where to go How to get there

How can | generate study Source Verification Listing page

. 1. Click Monitor.
completion reports for my study?

2. Con the left, click:

e SV Report
*  Visit Reports
* Reg Docs

How do | change my password?

1. For a non single sign-on (SSO) study:
a. Inthe upper-right corner of any page, click your picture or user name.
b. Fillin the fields, and click Submit.

2. For an SSO study with your Oracle Life Sciences IAMS credentials:
a. Inthe upper-right corner of any page, click your picture or user name.
b. On the left, click My Profile > My Information.
c. Fillin the fields in the Change Password section, and click Apply.

3. For an SSO study with your Federation credentials:

If you are using use your Federated login to log in to your study, you must follow your
Federated account's process for changing your password.

How do | reset a forgotten or expired password?

ORACLE

1. For a non single sign-on (SSO) study:
a. Click Forgot Your Password on the Login page.

b. Inthe Reset Password page, enter your user name, click Reset Password, and then
click Return to Login page.

An email with instructions for resetting your password is sent to the email address that
is associated with your Oracle InForm user account. It contains a link that you use to
reset your password.

# Note:

The application can only send one password reset email every 30 minutes.

c. Inthe email, click the link to reset your password.
The link is valid for 24 hours.

d. Inthe Reset Password page, enter and confirm your new password, and click
Submit.

e. Click Return to Login page.

f. Use your new password to log in to Oracle InForm.

1-3



Chapter 1
How do | log out of a study?

2. For an SSO study with your Oracle Life Sciences IAMS credentials:
a. Click Trouble Signing In on the Login page.
b. Enter your SSO account user name, and click Next.

c. If your account is set up to not require challenge questions, you will receive an email
with a link to reset your password.

d. If your account is set up to require challenge questions, answer the challenge
guestions you selected when you set up your SSO account, and click Next.

e Enter your new password, and click Save.
3. For an SSO study with your Federation credentials:

If you are using use your Federated login to log in to your study, you must follow your
Federated account's process for resetting a forgotten or expired password.

How do | log out of a study?

In the upper-right corner of any page, click the Logout button (Eéi ).

# Note:

If you are working in an SSO study and are using a Federation account for
authentication, be sure to close your browser to end your Federation account
session.
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Set up the Home page

In this chapter

e Add a company logo to the Home page
e Create and organize tabs on the Home page
e Create and modify sections in a tab on the Home page

e Upload and modify a document

Add a company logo to the Home page

The company logo appears in the Home page for a study that is defined with the Oracle
InForm Portal.

1. In the upper-left of the Home page, select the Admin tab.
2. Inthe Edit Records section, click Update Company Logo.

3. Browse to the image file, and click Open, then click Submit.

Create and organize tabs on the Home page

1. To create atab:

o

In the upper left of the Home page, click the Admin tab.

c

In the Add New Records section, click Tabs.
c. Fillin the fields, and click Submit.
d. To view the newly created tab, click Refresh.
2. Torename a tab:
a. Inthe upper left of the Home page, click the Admin tab.
b. In the Edit Records section, click Tabs.
c. To the right of the tab to be renamed, click Edit.
d. Make your changes, and click Submit.
3. Toreorder the tabs:
a. Inthe upper left of the Home page, click the Admin tab.
b. In the Edit Records section, click Tabs Order.
* To move the selected tab one place to the left, click Move Up.
* To move the selected tab one place to the right, click Move Down.

The page does not have a horizontal scroll bar, so make sure that all the tabs are visible
when the page is at full view.

4. To show or hide a tab:

a. Inthe upper left of the Home page, click the Admin tab.

ORACLE
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Chapter 2
Create and modify sections in a tab on the Home page

b. In the Edit Records section, click Tabs.
c. To the right of the tab you want to edit, click Edit.

d. Select or deselect Active, and click Submit.

Create and modify sections in a tab on the Home page

1. To add a section to a tab:
a. Inthe upper left of the Home page, click the Admin tab.
b. Inthe Add New Records section, click Sections.
c. Fillin the fields, and, click Submit.

The title appears on the tab only after a document has been uploaded to that section.
For more information, see Upload and modify a document.

2. To modify section properties:
a. Inthe upper left of the Home page, click the Admin tab.
b. In the Edit Records section, click Sections.
c. To the right of the section that needs to be edited, click Edit.
d. Edit the fields, and click Submit.

Upload and modify a document

To upload and modify documents, go to the Admin tab, found on the blue bar under the
navigation pane.

1. To upload a document;
Before you can upload any documents to a tab, the tab must contain at least one section.
a. Inthe Add New Records section, click Upload Documents.
b. Fillin the fields, and click Submit.

For IIS 10, the maximum file size is set to 4 MB by default. The setting can be resized
up to 30 MB by editing the web.config file, located in the
<Installation_Directory>\InForm\aspmvc directory. Add the following element to the
<system.web> node: <httpRuntime maxRequestLength="x"> to specify the file size
in kilobytes. For example, if you wanted to increase the maximum file size to 8 MB, the
entry would be: <httpRuntime maxRequestLength="8192">.

2. To modify a document's properties:

a. Inthe Edit Records section, click Update Documents.

b. Select the tab where your document is located, and click Submit.

c. Click Edit.

d. Edit any of the document properties except the RefName, and click Submit.
3. To make a document invisible:

a. Inthe Add New Records section, click Upload Documents.

b. Fillin the fields.

c. Inthe Is This Document Visible field, select No.
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Upload and modify a document

d. Click Submit.
4. To restrict access to a document:
a. Inthe Edit Records section, click Tabs.
b. To the right of the tab that needs to be edited, click Edit.

c. Select Sponsor, and click Submit.

ORACLE 2.3



Manage study data and subjects

Queries

In this chapter

Queries

Freeze and lock
Source verification
Subiject transfers

Review the audit trail

In this section

Create a query on an item in the Data Viewer
Create a query

Close a single query

Close multiple queries

Reissue a query

Change a candidate query to an open query

Delete a candidate query

Create a query on an item in the Data Viewer

ORACLE

Click Review.

Optionally, to sort the page by site, in the upper-left corner of the Data Viewer, select

Summary > Sites.

To open the Record Listing view:

a. Inthe table, select a cell in the Visit, Site, or Country column, or any cell that contains

data that you want to see in the Record Listing view.

For example, if the Summary view is sorted by visit, to open all the forms in the
Baseline visit for all sites, select the Baseline cell in the Visit column. To open the
Complete forms in the Baseline visit for all sites, select the data cell in the Baseline

row and the Complete column.

b. Atthe top of the Data Viewer, click Go to Record Listings.

In the table, highlight one or more cells with item data.

At the top of the Data Viewer, click the Create Query button ("'-?‘-}'3).

Enter the query information, and click Submit.
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Queries

Create a query

3.

For the item you want to create a query for, on the right, click Create Query ('-'-?I-Q).

For an item on a repeating form or in an itemset, click the row number and then click
Create Query.

Select a state for the query:
e Opened—Visible to all users.
e Candidate—Visible only to sponsor users.

Enter a reason for the query, and click Submit.

Close a single query

1.

2.
3.
4.

Click Queries.
In the Description column, click the query link.
Click Close Query.

Enter a reason for the change, and click Submit.

Close multiple queries

1.

2.
3.
4.

Click Queries.
At the bottom of the page, click Action View, and select the queries.
Select Close Query from the Action drop-down list.

Enter a reason for the change, and click Submit.

Reissue a query

If a response to a query does not resolve the issue, you can reissue the query.

1
2
3.
4

Click Queries.
In the Description column, click the query link.
Select Reissue as Open or Reissue as Candidate.

Enter a reason for the change, and click Submit.

Change a candidate query to an open query

1.
2.
3.

ORACLE

Click Queries.
From the Query Status drop-down list, select Candidate.
In the Description column, click the query link.

To open multiple queries, click Action View at the bottom of the page, and select the
queries.

Click Place Query In Opened State, or select Place Query In Opened State from the
Actions drop-down list.

Enter a reason for the change, and click Submit.
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Freeze and lock

Delete a candidate query

Click Queries.
From the Query Status drop-down list, select Candidate.
In the Description column, click the query link.

To delete multiple queries, click Action View at the bottom of the page, and select the
queries.

Click Delete Query, or select Delete from the Actions drop-down list.

Enter the reason for the change, and click Submit.

Freeze and lock

In this section

Freeze or lock in the Data Viewer
Freeze or lock a form

Freeze or lock repeating forms
Freeze or lock all forms in a visit

Freeze or lock a case report book for a subject

Freeze or lock in the Data Viewer

You can apply a freeze or lock to one or more forms at a site, in a visit, or that are assigned a
particular state, depending on the granularity of the Data Viewer view you are in when you
perform the action. You can also freeze or lock an individual item.

ORACLE

For example:

To apply a freeze or lock for all of the forms at all of your sites at one time, click Review to
open the Summary view.

If you filter the Summary view to see forms at a specified site, you can apply a freeze or
lock for all of the forms at that site at one time.

To apply a freeze or lock for all of the forms at that site one form at a time, click Review,
then select a cell and click Go to Record Listings to open the Record Listing view.

If you filter the Record Listings view to see forms at a specified site, you can apply a freeze
or lock for all of the forms at that site one form at a time.

In all of the Data Viewer views, you can filter to see forms at a specified site, associated with a
specific subject, in a specific visit, or assigned a specific form state. You can also filter to see
forms that were updated after a specified date, or that were updated since they were assigned
a specified custom review state.

1.

Freezing or locking one or more forms:
a. Click Review.

b. Review started and expected form data organized by visit.

To review started and expected form data organized by site, in the upper-left corner of
the Data Viewer, select Summary > Sites.

c. Inthe table, select one or more cells that contain data for the form or forms that you
want to freeze or lock.
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Freeze and lock

d. At the top of the Data Viewer, click the Freeze button (") or the Lock button (:-“-).
2. Freezing or locking an item:
a. Click Review.

b. Optionally, to sort the page by site, in the upper-left corner of the Data Viewer, select
Summary > Sites.

c. To open the Record Listing view:

i. Inthe table, select a cell in the Visit, Site, or Country column, or any cell that
contains data that you want to see in the Record Listing view.
For example, if the Summary view is sorted by visit, to open all the forms in the
Baseline visit for all sites, select the Baseline cell in the Visit column. To open the
Complete forms in the Baseline visit for all sites, select the data cell in the Baseline
row and the Complete column.

ii. Atthe top of the Data Viewer, click Go to Record Listings.

d. On the left, under Forms, select the form that contains the item you want to freeze or
lock.

e. Inthe table, select the cell with the item's data.

f. Atthe top of the Data Viewer, click the Freeze button (*) or the Lock button (:-L-).

Freeze or lock a form

1. Click Subjects.

2. Select a visit.

3. On the left, select the form you want to freeze or lock.
4. At the bottom of the page, click Freeze or Lock.

When a form is already frozen or locked, the Unfreeze and Unlock buttons appear instead.

Freeze or lock repeating forms

1. At the top-right of one of the forms, select [Summary] from the drop-down list.

2.  While in summary view, click Freeze Visit, Unfreeze Visit, Lock Visit, or Unlock Visit.
3. Select the checkbox for each form instance that you want to freeze or lock.
4.

Click Freeze Visit, Unfreeze Visit, Lock Visit, or Unlock Visit.

Freeze or lock all forms in a visit

1. Click Subjects.

2. Select the visit you want to freeze or lock.

3. At the bottom of the page, in the Select Action drop-down list select Freeze Visit or Lock
Visit.

4. Click Apply

Freeze or lock a case report book for a subject

1. Click Subjects.
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Select the Subject ID of the subject whose case report book you want to lock.

At the bottom of the page, click Freeze Book or Lock Book. When a case report book is
already frozen or locked, the Unfreeze Book and Unlock Book buttons appear instead.

# Note:

Oracle InForm applies the frozen or locked status to all forms in the case report
book.

Source verification

In this section

Source verify data in the Data Viewer
Source verify data
Source verify data for a specific subject

Configure Partial SV

Source verify data in the Data Viewer

Show me how to source verify data in the Data Viewer (Video)

ORACLE

Find the data you want to source verify

You can source verify one or more forms at a site, in a visit, or that are assigned a particular
state, depending on the granularity of the Data Viewer view you are in when you perform the
action. You can also source verify an individual item.

For example:

To source verify all of the forms at all of your sites at one time, click Review, and then
select Summary > Sites.

If you filter the Summary view to see forms at a specified site, you can source verify all of
the forms at that site at one time.

To source verify all of the forms at one site one form at a time, click Review, then select a
cell and click Go to Record Listings to open the Record Listing view.

If you filter the Record Listings view to see forms at a specified site, you can source verify
all of the forms at that site one form at a time.

In all of the Data Viewer views, you can filter to see forms at a specified site, associated with a
specific subject, in a specific visit, or assigned a specific form state. You can also filter to see
forms that were updated after a specified date, or that were updated since they were assigned
a specified custom review state.

1.

Source verify one or more forms:
a. Click Review.
b. To review started and expected form data organized by visit, select Summary > Visits.

c. To review started and expected form data organized by site, in the upper-left corner of
the Data Viewer, select Summary > Sites.

d. Filter the page to view the data you want to see.
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In the table, select one or more cells that contain data for the form or forms you want
to source verify.

For example, to source verify all Complete forms for the Baseline visit at all sites, filter
the page to show all site data, then select the cell in the Baseline row in the Complete
column.

At the top of the Data Viewer, from the Source Verification drop-down list ( ¥), select
Mark item verified or Mark item not verified.

Source verify an item:

a.

b.

Click Review.

Optionally, to sort the page by site, in the upper-left corner of the Data Viewer, select
Summary > Sites.

To open the Record Listing view:

i. Inthe table, select a cell in the Visit, Site, or Country column, or any cell that
contains data that you want to see in the Record Listing view.
For example, if the Summary view is sorted by visit, to open all the forms in the
Baseline visit for all sites, select the Baseline cell in the Visit column. To open the
Complete forms in the Baseline visit for all sites, select the data cell in the Baseline
row and the Complete column.

ii. Atthe top of the Data Viewer, click Go to Record Listings.

On the left, under Forms, select the form that contains the item or items you want to
source verify.

In the table, select the cell with the item's data.

At the top of the Data Viewer, from the Source Verification drop-down list ( ¥), select
Mark item verified or Mark item not verified.

Source verify data

Click Monitor.

ORACLE

Optionally, sort and filter the page to see the data you want to source verify.

a.

b.

Click Monitor.
In the Filter drop-down list, do one of the following:
«  To modify an existing filter, select the filter name.

e To create a new filter, select the blank area (that is, make sure that nothing is
selected).

To the right of the Filter drop-down list, click Edit.

Select the content and status criteria for the filter. You must make at least one
selection in each category.

# Note:

In the Visit category, select CCRF to list all instances of a common form.

Optionally, to view a summary of your selections, click the icon in the lower-right corner

(2.
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f. To apply the filter without saving it, in the lower-right corner, click Apply.
To save the filter, in the lower-left corner, click Save and provide a name for the filter.
In the CRF column, click the abbreviation for the form that has data to source verify.

Select the items that you want to source verify. To verify the entire form, select all of the
required and critical items.

Click Submit.

Source verify data for a specific subject

1.
2.

Click Subjects.

In the row for the subject, click the status icon for the visit with the form that has data to
source verify.

or

Click the subject number, and then click the status icon for the visit with the form that has
data to source verify.

Select the form, and at the bottom of the page, click Verify.
Select the items to source verify, and click Submit.
Click Stop Verifying.

Configure Partial SV

ORACLE

Click Monitor.
Click Set SV Settings.
Select Partial Source Verification.

The Subject Selection tab appears and displays the system default SV settings that are
defined in Oracle Central Designer. The settings are read-only.

* You can modify the SV settings on a site-by-site basis, overriding the default values;
proceed to Step 4.

*  You can manually add subjects to the SV pool; proceed to Step 5.

Modify the system default SV settings for a site.

a. Inthe upper-right of the dialog box, in the Site drop-down list, select a site.
b. Click the Subject Selection tab.

c. Inthe System default SV settings section, enter the following information:
d. Enter the following information:

*  Number of initial subjects—The number of subjects to source verify in order,
based on the time when the subject is assigned the status Enrolled. For example,
to indicate that you must source verify the first seven subjects enrolled in a study,
specify SVFIRSTNSUBJECTS=7. The default value is defined in Oracle Central
Designer. This can't be less than zero (0). If the system does not contain a
SVFIRSTNSUBJECTS setting, the default value will be one hundred (100).

The auto select percentage is also a Site property. A user with the Change Site
SV Settings right can change the value at the Site level. When deployment takes
place, the Site values in Oracle InForm will not necessarily be changed as a result
of the deployment. The site values are only updated if they match the current
default values. That is, if all Site Values match the Default Values, the Site Values
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will be changed to the new Default Values that were included in the deployment
from Oracle Central Designer; however, if any of the Site Values do not match the
Default Values, the Site Values will remain as is.

Subject selection rate after initial subjects—The auto select percentage of the
subjects to be included in Partial SV. The default value is defined in Oracle Central
Designer. The value must be in the range of 0 to 100. If the system does not
contain a SVAUTOSELECTRATE setting, the default value will be one hundred
(100).

The auto select percentage is also a Site property. A user with the Change Site
SV Settings right can change the value at the Site level. When deployment takes
place, the Site values in Oracle InForm will not necessarily be changed as a result
of the deployment. The site values are only updated if they match the current
default values. That is, if all Site Values match the Default Values, the Site Values
will be changed to the new Default Values that were included in the deployment
from Oracle Central Designer; however, if any of the Site Values do not match the
Default Values, the Site Values will remain as is.

If you select a rate of 100%, all forms for all subjects at the site with at least one
item marked as SV Required must be verified.

For more information on SVAUTOSELECTRATE selection criteria, see How does
Partial SV subject selection work?

Whether subjects should be included in the SV Eligible Pool or the Excluded
Subjects pool by default—The SVDEFAULTINCLUDE system setting defines
whether to include or exclude all subjects from the SDV pool by default. Make sure
that this setting is set to Include (default) or Exclude depending on the default
behavior you want.

# Note:

Set to Include if you are not using rules to determine which subjects
should or should not be in SV eligible pool. Otherwise, If you are using
rules, you need to decide whether to exclude the subjects prior to those
rules triggering so that the only SV eligible subjects based on the rule are
included. For more information, see the Oracle Central Designer User
Guide.

For more information, see How does Partial SV subject selection work?

Optionally, add specific subjects whose data you want to be source verified by manually
adding the subjects to the SV pool.

These subjects are not considered in the SV Target Rate calculation.

a.

b.

Click the Subject Selection tab.

In the Select the subjects that will be verified at 100% section, enter the following
information:

Enter or select a subject ID or subject number, and click Add.

On the right, click Import Subject List, submit the file with the list of subjects, and
click OK.
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# Note:

If your imported subject list contains data for subjects who are not present at the
site, marked as excluded, or already present in the Manual Pool, those subjects
are not imported. You are notified about who is and is not eligible after import.

Optionally, deselect subjects whose data you don't want to be source verified.

When you deselect a subject, the subject is returned to the SV Pool, and could be selected
for source verification in the future by the automatic subject selection settings (Number of
initial subjects and Subject selection rate after initial subjects).

a. Click the Subject Selection tab.

b. Inthe Enter subject number drop-down list, enter the subject's Subject ID or subject
number, and click Add.

c. Select the subject number in the Subjects selected for verification list box, and click the
Remove icon ( 4 ) two times.
Optionally, exclude subjects from source verification settings.

Excluded subjects are removed from the SV Eligible Pool, which means they aren't
considered in the automatic subject selection settings, and are not SV required unless you
manually select them for source verification. You can, however, mark an item associated
with an excluded subject as critical.

a. Click the Subject Selection tab.

b. Inthe Enter subject number drop-down list, enter the subject's Subject ID or subject
number, and click Add.

c. Select the subject number in the Subjects selected for verification list box, and click the
Remove icon ( ﬁ) one time.

Mark forms as critical for all subjects (add them to the critical forms list).

a. Click the Critical Data tab.

b. Inthe Form drop-down list, select a form with that you want verified for all subjects at
the site.

c. Inthe Form override drop-down list, select Critical, and click OK.
Override form criticality settings.
a. Click the Critical Data tab.

b. Inthe Form drop-down list, select a form with that you want verified for all subjects at
the site.

c. Inthe Form override drop-down list, select one of the following, and click OK.
e Study Default—The criticality set for the form during the study design.
*  Critical—Sets the selected form to critical.
* Not Critical—Sets the selected form to not critical.

Optionally, override item criticality settings.

a. Click the Critical Data tab.

b. Inthe Forms drop-down list, select a form with the item that you want to mark as
critical.
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c. Inthe table, select the item, and click Edit Selected Item.
d. Select the forms you want to set the item criticality for.

e. Select the criticality setting for the item:

* Not Critical—Sets the item or itemset to not critical for the selected form(s).

*  Critical—Sets the item or itemset to critical for the selected form(s).

e Study Default—The criticality set for the item during the study design.

f. To make the item critical for subjects who are excluded from the SV Pool, in the

Eligible subjects section, select the subjects and click Add.

# Note:

section.

11. Provide a reason for the change, and click OK.

Subject transfers

In this section

e Transfer a subject
* View the audit trail for a transferred subject

* View a subject transfer archive

Transfer a subject

Click Admin.
On the left, click Sites.

1.
2.
3. In the Subjects column for the subject's site, click Transfer.
4. In the Action column for the subject, click Transfer.

5.

Read the following sections of the page:
* Subject Record Transfer Affidavit
* Subject Status

# Note:

If you continue, you are assuming responsibility for the subject transfer as
described in the affidavit.

6. Fillin the fields, and click Submit.

View the audit trail for a transferred subject

1. Click Admin.

ORACLE

If you set the item criticality to Study Default, study default is applied to all
subjects. You cannot specify a subset of subjects in the Eligible subjects
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On the left, select Sites.

Locate the site where the subject is currently enrolled, and in the Subjects column, click
List or Transfer.

# Note:

The name of the link depends on your rights; Transfer appears only when you
have the Subject Transfer right.

In the Audit Trail column, click the Audit trail icon (%\? ).

View a subject transfer archive

1
2
3.
4

Click Subjects.
On the bottom of the page, click Show Transferred.
In the Archive column, click View in the row for a subject.

Click the title of a form to view its details.

Review the audit trall

You can view the audit trail in different ways, depending on what task you're completing. You
can also view audit trail data by running the Audit Trail Report in the Reporting and Analysis
module.

If you're entering data on a form:

=
Click the audit trail icon ( =~ ) for an item.

If you're changing or reviewing form data:

1.
2.
3.

or

ORACLE

Click the data entry field for the item.
On the Data Value(s) page, select a change date and time from the Audit Trail list.

Review the details in the Reason for Change section.

Click the data entry field for the item.
On the left side of the Data Value(s) page, click Audit Trail.
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Review study data in the Data Viewer

In this chapter

What can | do in the Data Viewer?
Review a summary of started form data
Review data for started forms

Compare clinical data on two forms
Review comments

Use review states in the Data Viewer
Customize the Data Viewer workspace
Custom Data Viewer views

Export data to Excel

What can | do in the Data Viewer?

The Data Viewer provides a summary of the status of the study using real time data. In the
Data Viewer you can:

Review operational data counts in the Summary view, which can be filtered by visit
(default), site, or subject.

Review clinical data in the Record Listing view.

Compare form data in the Record Comparison view.

Review form and item comments.

Create custom views, which allow you to view data from multiple forms on one page.

Perform tasks like creating queries, freezing or locking forms or items, source verifying
data, and assigning custom review states.

Review a summary of started form data

Click Review.
Review started form data organized by visit.

or

To review started form data organized by site, in the upper-left corner of the Data Viewer,

select Summary > Sites.

Review data for started forms

In this section

ORACLE

Review a single form for a single subject
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Reviewing a single form across subjects, visits, or sites

Review form details and audit history

Review a single form for a single subject

Use this procedure to focus on the clinical data on a particular form for a single subject across
visits to see if there are any abnormalities or patterns.

1.
2.

Click Review.

Optionally, to sort the page by site, in the upper-left corner of the Data Viewer, select
Summary > Sites.

To open the Record Listing view:

a. Inthe table, select a cell in the Visit, Site, or Country column, or any cell that contains
data that you want to see in the Record Listing view.
For example, if the Summary view is sorted by visit, to open all the forms in the
Baseline visit for all sites, select the Baseline cell in the Visit column. To open the
Complete forms in the Baseline visit for all sites, select the data cell in the Baseline
row and the Complete column.

b. At the top of the Data Viewer, click Go to Record Listings.

To display the first available form for the subject, in the table, click a link in the Subject
column.

Optionally, select different forms on the left, and continue reviewing form-level data for a
single form and single subject.

Reviewing a single form across subjects, visits, or sites

Click Review.

Optionally, to sort the page by visit, in the upper-left corner of the Data Viewer, select
Summary > Visits.

In the table, click a data cell.
At the top of the Data Viewer, click Go to Record Listings.

On the left, under Forms, click the form you want to view clinical data for. You can see one
row for each site, subject, and visit for the selected form.

Review form details and audit history

ORACLE

Click Review.

Optionally, to sort the page by site, in the upper-left corner of the Data Viewer, select
Summary > Sites.

To open the Record Listing view:

a. Inthe table, select a cell in the Visit, Site, or Country column, or any cell that contains
data that you want to see in the Record Listing view.

For example, if the Summary view is sorted by visit, to open all the forms in the
Baseline visit for all sites, select the Baseline cell in the Visit column. To open the
Complete forms in the Baseline visit for all sites, select the data cell in the Baseline
row and the Complete column.

b. At the top of the Data Viewer, click Go to Record Listings.
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At the bottom right, click the arrow to expand the Details pane.

Compare clinical data on two forms

1.
2.

Click Review.

Optionally, to sort the page by site, in the upper-left corner of the Data Viewer, select
Summary > Sites.

To open the Record Listing view:

a. Inthe table, select a cell in the Visit, Site, or Country column, or any cell that contains
data that you want to see in the Record Listing view.

For example, if the Summary view is sorted by visit, to open all the forms in the
Baseline visit for all sites, select the Baseline cell in the Visit column. To open the
Complete forms in the Baseline visit for all sites, select the data cell in the Baseline
row and the Complete column.

b. Atthe top of the Data Viewer, click Go to Record Listings.

On the left, under Forms, select a form.

At the top of the Data Viewer, from the Open Comparison View drop-down list (@), select
a form that you want to compare the selected form to.

Optionally, to change the form that appears in either view, select another form from the
form name drop-down list in the section header.

Optionally, to filter the data, click the Filter icon ("f).

or

To filter the data using clinical data values, click the Filter column data icon ('—TE' ).

At the top of the Data Viewer, click Close Comparison View.

Review comments

In this section

Review comments for a single form
Review comments for all forms

Mark comments as reviewed

Review comments for a single form

ORACLE

Click Review.

Optionally, to sort the page by site, in the upper-left corner of the Data Viewer, select
Summary > Sites.

To open the Record Listing view:

a. Inthe table, select a cell in the Visit, Site, or Country column, or any cell that contains
data that you want to see in the Record Listing view.

For example, if the Summary view is sorted by visit, to open all the forms in the
Baseline visit for all sites, select the Baseline cell in the Visit column. To open the

4-3



Chapter 4
Review comments

Complete forms in the Baseline visit for all sites, select the data cell in the Baseline
row and the Complete column.

b. Atthe top of the Data Viewer, click Go to Record Listings.

At the top of the Data Viewer, click View Comments ( ).

e If text appears in the Item column, the comment is an item-level comment.

« If text does not appear in the Item column, the comment is a form-level comment.
Optionally, filter and sort the comments, or export the data.

To find the form a comment was entered on, highlight a row and click View in Record
Listings.

Review comments for all forms

Click Review.

Optionally, to sort the page by visit, in the upper-left corner of the Data Viewer, select
Summary > Visits.

At the top of the Data Viewer, click View Comments ( ).
e |If text appears in the Item column, the comment is an item-level comment.
e If text does not appear in the Item column, the comment is a form-level comment.

Optionally, filter and sort the comments, or export the data.

To find the form a comment was entered on, highlight a row and click View in Record
Listings.

Mark comments as reviewed

Data Viewer provides a way to mark comments as reviewed. Marking a comment as reviewed
is not considered to be a clinical data change.

ORACLE

When you mark a comment as reviewed:

The Data Viewer immediately saves the user name, date, and time that the comment was
marked as reviewed to the database.

After you mark a comment as reviewed, the comment and its review status are shown to
all reviewers.

Any update to a comment in the InForm application unmarks the comment within the Data
Viewer. The Data Viewer displays the user name and date of review as a tooltip when you
hover over the checkbox within the Comments View dialog box.

The saved date and time are local.

The date format is determined for each user by the setting in the Date Format field on the
User details page in the Admin user interface.

To mark a comment as reviewed:

1.

2.

Click Review.

At the top of the Data Viewer, select Reporting > Comments ().

or
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Do the following:

a. Inthe table, click a cell in the Visit, Site, or Country column, or any cell that contains
data.

b. Atthe top of the Data Viewer, click Go to Record Listings.
c. Atthe top of the Data Viewer, click View Comments.

Select the checkbox next to a comment to mark it as reviewed.

Use review states in the Data Viewer

1.
2.

Click Review.

To assign a custom review state to a visit or all visits for a site, click one or more cells that
contain data.

or
To assign a custom review state for a form or all forms for a visit:

* Inthe table, click a cell in the Visit, Site, or Country column, or any cell that contains
data.

* At the top of the Data Viewer, click Go to Record Listings.

Highlight one or more rows.

At the top of the Data Viewer, from the Review drop-down list (I_a), select the custom
review state you want to assign to the selected data.

Optionally, enter a comment (20 characters maximum) that describes the custom review
state assignment, and click OK.

Customize the Data Viewer workspace

In this section

Filter the data in the Data Viewer

Customize the columns in the Data Viewer

Filter the data in the Data Viewer

In this section

Filter by site, visit, state, or date
Filter on clinical data
Clear a filter

Load, save, and delete a filter

Filter by site, visit, state, or date

1.
2.

ORACLE

Click Review.
On the left, specify the filter criteria, and click Apply.

The filter is applied for all Data Viewer views in the same session.
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# Note:

When filtering by date, you can select a From Date and/or To Date range.
Entered dates are inclusive.

Filter on clinical data

Clear afilter

You can filter on any one column at a time, except for the columns for the review states, site,
subject, and visit.

Columns that contain entered values are filtered by the normalized value.

For each column you filter, you can select up to five filtering criteria that are appropriate for
the column type (for example, numeric, case-insensitive alphanumeric, or date).

Column filtering is applied only in the current view. All column filtering selections are lost
when you navigate away from the current view.

To filter on clinical data:

Click Review.

Optionally, to sort the page by site, in the upper-left corner of the Data Viewer, select
Summary > Sites.

To open the Record Listing view:

a. Inthe table, select a cell in the Visit, Site, or Country column, or any cell that contains
data that you want to see in the Record Listing view.

For example, if the Summary view is sorted by visit, to open all the forms in the
Baseline visit for all sites, select the Baseline cell in the Visit column. To open the
Complete forms in the Baseline visit for all sites, select the data cell in the Baseline
row and the Complete column.

b. At the top of the Data Viewer, click Go to Record Listings.

In the table, click a cell that contains data.

On the left, click the Filter column data icon (l—_.? ).
Enter the filtering criteria.

To add another row of criteria, click the plus sign (+), and click Apply.

On the bottom left of the Data Viewer, to the left of the Apply button, click Show All.

Load, save, and delete a filter

ORACLE

1.
2.

Click Review.

On the left, do the following:
* To save afilter, select the filter criteria and click the Save icon (H!).
e To open a saved filter, click the Load filter drop-down list (EIJ), and select the filter.

« To delete a saved filter, click the Delete filter drop-down list (""‘JII), select a filter to
delete, and click OK.
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Customize the columns in the Data Viewer

In the Data Viewer, all column customizations are saved automatically for the current user, and
are reloaded automatically for subsequent sessions. You can do the following:

Resize a column:

—  Click the separator between any two columns, and drag the column to the desired
width.

Reorder column positions:

— Inthe table, drag and drop data column headings to the position you want them in.
Show or hide columns:

1. Select Options > Configure Columns.

2. Select the checkboxes for the columns you want to display.

# Note:

You can't hide the Subject column.

Configure column names:
1. Select Options > Configure Columns.

2. From the Header Names drop-down list, select the type of column names that you
want to use.

— Report element—Cognos Reporting column names.
— Reporting data extract column—RDE column names.

3. Click Apply.

Custom Data Viewer views

In this section

Create a custom view
Display a custom view

Delete a custom view

Create a custom view

ORACLE

Click Review.

Optionally, to sort the page by site, in the upper-left corner of the Data Viewer, select
Summary > Sites.

To open the Record Listing view:

a. Inthe table, select a cell in the Visit, Site, or Country column, or any cell that contains
data that you want to see in the Record Listing view.

For example, if the Summary view is sorted by visit, to open all the forms in the
Baseline visit for all sites, select the Baseline cell in the Visit column. To open the
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Complete forms in the Baseline visit for all sites, select the data cell in the Baseline
row and the Complete column.

b. Atthe top of the Data Viewer, click Go to Record Listings.

On the left, under Forms, click the Create custom view button (E]).

On the left, select a form and then select the items on the form that you want to add to the
custom view.

Click Add.

Enter a name for the custom view, and click Create. The view appears in either the Record
Listing view or Record Comparison view.

Display a custom view

Click Review.

Optionally, to sort the page by site, in the upper-left corner of the Data Viewer, select
Summary > Sites.

To open the Record Listing view:

a. Inthe table, select a cell in the Visit, Site, or Country column, or any cell that contains
data that you want to see in the Record Listing view.

For example, if the Summary view is sorted by visit, to open all the forms in the
Baseline visit for all sites, select the Baseline cell in the Visit column. To open the
Complete forms in the Baseline visit for all sites, select the data cell in the Baseline
row and the Complete column.

b. At the top of the Data Viewer, click Go to Record Listings.

On the left, under Forms, select the custom view you want to view.

Delete a custom view

ORACLE

Click Review.

Optionally, to sort the page by site, in the upper-left corner of the Data Viewer, select
Summary > Sites.

To open the Record Listing view:

a. Inthe table, select a cell in the Visit, Site, or Country column, or any cell that contains
data that you want to see in the Record Listing view.

For example, if the Summary view is sorted by visit, to open all the forms in the
Baseline visit for all sites, select the Baseline cell in the Visit column. To open the
Complete forms in the Baseline visit for all sites, select the data cell in the Baseline
row and the Complete column.

b. At the top of the Data Viewer, click Go to Record Listings.
On the left, under Forms, select a custom view.
Click the Delete custom view button (\~*_). Depending on the contents of your custom

view, the button appears on the left, under Forms, or in the top or bottom panel of the
Record Comparison view.
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Export data to Excel

In this section

Export data

Export data

Export comments

1. Click Review.
2. Atthe top of any Data Viewer view, click the Excel button (E).
* Any item that has queries in any state except the Closed state is italicized in Excel.
« If the current view is a Record Comparison View, only the active view is exported.
e The data has the selected sorting and filtering criteria, and the product and study
locale settings defined for the current view.
Export comments
1. Click Review.
2. Atthe top of the Data Viewer, select Reporting > View Comments.
or
To open the Record Listing View:
a. Inthe table, click a cell in the Visit, Site, or Country column, or any cell that contains
data.
b. Atthe top of the Data Viewer, click Go to Record Listings.
3. Atthe top of the Data Viewer, click the Excel button (E).

ORACLE

# Note:

Items with queries that are not in the Closed state are italicized in the export file.
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Run reports

In this chapter

* Run areport

Run a report

1. Click Reports.

2. If you want to run a standard report, on the left, select Team content, and select the folder
where the standard reports are stored.

or

If you want to create a report using the Cognos Reporting interface, on the left, click New,
and click Report.

Reporting capability in Oracle InForm is provided by Cognos. For more information, see the
Reporting and Analysis Guide and the Cognos documentation.
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Move a site to a new study version

In this chapter
e Deploy a study
e Cancel a scheduled deployment

e Access and delete the deployment log

Deploy a study

We recommend that you use Oracle Central Designer for all deployment tasks. For hosted
studies using Oracle InForm release 6.1 and higher, you are required to use the
autodeployment feature in Oracle Central Designer. For more information, see the Oracle
Central Designer User Guide.

1. Click Deployment.
2. Browse to select a deployment package.

3. To run the deployment package immediately, click Now.

# Note:

If your study is live, the deployment runs in five minutes. If you need to cancel the
deployment, you must do it within that five minute window.

To run the deployment package later, schedule a time and date to deploy the study
package.

# Note:

The execution time is the time the deployment starts in the local time of your
browser.

4. Click Done, and click Upload.

Cancel a scheduled deployment

1. Click Deployment.

2. In the Action column, click Cancel.

Access and delete the deployment log

1. Click Deployment.
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Chapter 6
Access and delete the deployment log

To view or save the deployment log, in the Action column, click View Log, and to save the
log, click Save Log

or

To delete the deployment log, in the Action column, click Delete Log.

# Note:

When you delete the deployment log, the study package for that deployment is
also deleted.
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Generate study completion reports

In this chapter

Create a Site Visit report form

Complete the regulatory document checklist for a site

Create a Site Visit report form

1. Click Monitor.

2. Onthe left, click Visit Reports.

3. Atthe bottom of the page, select the site to create the report for, and click New.
4.

Complete the form, and at the bottom of the page, click Submit.

Complete the regulatory document checklist for a site

1. Click Monitor.

2. Onthe left, click Reg Docs.
3. Select a site.
4.

Complete the fields and click Submit.

ORACLE -



FAQS

In this chapter

*  Query FAQs

e Freezing and locking FAQs

e Source verification FAQs

e Partial SV FAQs

e Data Viewer FAQs

e Subject transfer FAQs

e Audit trail FAQs

e Automated deployment FAQs
e Home page FAQs

e System alert FAQs

e User Acceptance Testing FAQs

Query FAQs

In this section

*  What types of queries can | work with?
*  Why can't | see a query that | expected to see?

* How can I find answered queries that | need to close?

What types of queries can | work with?

There are two types of queries that sponsor users can work with:

» Candidate—Created by and visible only to a CRA or sponsor staff. You can either open a
candidate query and assign it to a site user to be answered, or delete it.

*  Answered—CRA or sponsor users can review an answered query and close or reopen it.

Why can't | see a query that | expected to see?

The item the query is on was marked as hidden for your user group.

How can | find answered queries that | need to close?

You can find answered queries by site or subject.

* To see answered queries for all subjects at a site, click Queries, and use the Query Status
filter to see answered queries.
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* To see answered queries for one subject at a site, click Subjects, and click the visit icon
that includes the answered query icon (ﬂ).

Freezing and locking FAQs

In this section

*  What is freezing? What is locking?

* How can | tell when something is frozen or locked?
*  Why can't | see the freeze or unlock options?

*  Why are some forms in a locked visit unlocked?

What is freezing? What is locking?

Freezing and locking data prevent changes to forms, visits, or case report books:

« Freezing prevents data entry and updates, including entry of comments, but does not
prevent query, source verification, and signing activities.

e Locking prevents all activities except signing.

How can | tell when something is frozen or locked?

A frozen () or locked (rj) icon is added to the status icon.

When you freeze or lock a common form, Oracle InForm updates the status icon that
represents the form in the Time and Events Schedule in all visits where the form exists.

Why can't | see the freeze or unlock options?

The buttons or options you see at the bottom of the page depend on your rights and the state
of the form, visit, or case report book. For example, if you have the right to freeze a form but
not to lock it, only the Freeze button is present.

Why are some forms in a locked visit unlocked?

When you freeze or lock a visit, the status of any common form in the visit does not change.
You can freeze or lock a common form at the form or case report book level.

Source verification FAQS

In this section

e Where do | go to verify a form or item?

e How can | see the SV status of all of the subjects at my sites?

*  What are the available SV states?

*  What does it mean if a form is Verified?

e What if someone changes data that was already source verified?

e A subject at my site has locked forms. Can | still require source verification of that subject's
data?
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Where do | go to verify a form or item?

Click Monitor, then in the CRF column, click the abbreviation for the form that has data to
source verify.

Click Subjects, then click a status icon for the visit with the form that has data to source
verify, and click the form name on the left.

Click Subjects, then click the subject number for the subject whose form has data to
source verify.

How can | see the SV status of all of the subjects at my sites?

At the top of the page, click Monitor. A table appears with a row for each form that requires
source verification at one visit for a single subject, and each instance of a repeating form in its
OowWn row.

What are the available SV states?

Table 8-1 List of available SV statuses

_________________________________________________________________________________|
State Description

All All started forms.

Note: This state is an option only when you are
creating a custom filter.

Not Verified A form marked as SV Required in the study design
is not verified.

Not Complete An item marked as SV Required in the study
design is not verified.

Verified The form has no unverified items.

Note: If you modify data or add a comment to a
form that is Verified, the state of the form reverts to
Not Verified.

SV Ready The form has been marked by a user as ready for
source verification.

Not SV Ready The form has been marked by a user as not ready
for source verification.

What does it mean if a form is Verified?

The Verified form state means that there are no unverified items on the form.

ORACLE

A form is verified if:

The form has no items that require verification.
Items that require verification were manually verified.

The only item on a form that requires verification is an itemset, but no instances (rows) of
that itemset have been created.

— This happens because in Oracle InForm you verify itemset rows, not individual items
within the itemset.
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You must manually verify a form if:

e The only item on the form that requires verification is an itemset, and the instances (rows)
of that itemset have been started.

# Note:

You can't verify a form if it has a hidden item that requires verification. We
recommend updating the study design so that this doesn't occur.

What if someone changes data that was already source verified?

The form or item is un-verified if:
e The value of a data item on a form changes.
e Aform or item comment is entered.
— Form comments un-verify every item on the form.
— An item comment un-verifies just that item.
* Repeating forms or itemset rows are deleted or undeleted.

— The form or the itemset row is un-verified.

When the verification status changes, Oracle InForm highlights the form or item so that you
can re-verify it.

e The source verification status of the form changes to a status that indicates that source
verification is incomplete.

* You can see this change in the Source Verification Listing page.

A subject at my site has locked forms. Can | still require source verification
of that subject's data?

Yes. A form may be locked before it is designated for source verification, and then selected for
Partial SV at a later point in the study. This can happen if your study uses Partial SV and the
form is for a subject who was selected for source verification or because the form is on the
critical forms list.

Partial SV FAQs

ORACLE

In this section

*  What is partial SV?
e If l use Partial SV settings, can | source verify more than is required?
* How does Partial SV subject selection work?

* If | decrease my SV Target Rate, how does InForm choose which subjects to remove from
the SV Pool?

e | imported a subject list, and then configured my Partial SV settings so that the first 5
subjects are source verified. Why isn't the data for my imported subjects marked as SV
Required?
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*  What's the difference between excluding a subject from source verification and deselecting
a subject for source verification?

Do my Partial SV settings automatically recalculate?

* When | transfer a subject, is the subject assigned to the same Partial SV Pool at the new
site?

* What is a critical form, and why would | mark a form as critical?

*  What is a critical item and why would | mark an item as critical?

e Can I mark an item in an itemset as critical?

e What if the item | want to mark critical isn't listed in the Set SV Settings dialog box?
* How can | tell if an item is critical?

* | marked an item as critical for all forms, but | want to change it so that it's only critical for a
subset of forms. Can | do that?

* Why do | see more items in the Set SV Settings dialog box than on the actual forms?

What is partial SV?

In large studies, you may want to source verify a subset of data points marked as SV
Required. Partial source verification (Partial SV) is a feature that allows you to provide
parameters for selecting a subset of these data points for verification.

The default Partial SV settings (with parameters for subjects, forms, and items) are defined in
Oracle Central Designer for all sites. You can modify the Partial SV settings on a site-by-site
basis, overriding the default values, using the Oracle InForm Admin user interface or MedML.

If | use Partial SV settings, can | source verify more than is required?

Yes. Partial SV allows you to specify the minimum amount of source verification that is
required, but you can always verify more.

How does Partial SV subject selection work?

ORACLE

In terms of Partial SV, there are several groups, or pools of subjects at a site. When you
configure your Partial SV settings, you are sorting subjects at each site into the pools. Take a
look at the graphic below.
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— Excluded subjects

e General Pool—All of the subjects at a site.

e SV Pool—Subjects whose data requires source verification because they're in the Auto-
Select Pool or the Manual Pool.

— Auto-Select Pool—Subjects who were selected by the SV Target Rate or Number of
initial subjects settings.

— Manual Pool—Subjects who you manually added using the Enter subject number
drop-down list, or by importing a subject list.

e SV Eligible Pool—Subjects who are available to be added to the SV Pool. Subjects in the
SV Eligible Pool can be added to the SV Pool if you manually add them, or if you increase
the SV Target Rate or Number of initial subjects settings.

e Excluded Subjects—Subjects who can't be added to the Auto-Select Pool in the SV Pool.
The only way you can require source verification for these subjects' data is by manually
adding them using the Enter subject number drop-down list, or by including them in an
imported subject list.

¢ Note:

Iltems associated with excluded subjects can still be marked as critical.

The Auto-Select system selects a percentage of subjects from the SV Eligible Pool depending
on the value set in the SVAUTOSELECTRATE setting. Values can be assigned from 1 to 100.
Only subjects in the SV Eligible Pool will be considered for Auto-Select selection, therefore
manually selected subjects will not be included in this percentage.

If | decrease my SV Target Rate, how does InForm choose which subjects
to remove from the SV Pool?

ORACLE

Oracle InForm ranks the subjects by the current number of forms that are source verified, and
removes subjects with the fewest source verified forms first. Those subjects return to the SV
Eligible Pool. This ensures that the least amount of additional source verification work is
required when the target rate is reduced.

For example:
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If subject 01-004 has one form source verified, subject 01-007 has two forms source verified,
and subject 01-012 has three forms source verified:

e The process returns 01-004 to the SV Eligible Pool if the rate reduction called for removing
a single subject.

« If the rate reduction called for removal of two subjects from the Auto-select Pool, then
subjects 01-004 and 01-007 would be returned.

e This occurs so that reduction of the Auto-select Pool maintains a preference for retaining
subjects with the highest number of SV Complete forms for the study. This ensures that the
least amount of additional source verification work is required when the target rate is
reduced.

| imported a subject list, and then configured my Partial SV settings so that
the first 5 subjects are source verified. Why isn't the data for my imported
subjects marked as SV Required?

Imported subjects are not part of the Auto-select Pool, and they do not affect the SV Target
Rate for the site.

What's the difference between excluding a subject from source verification
and deselecting a subject for source verification?

Deselected subjects are subjects that you initially selected for source verification, but
subsequently deselected. After you deselect a subject for source verification, it is still possible
for the subject to be selected for source verification in the future by the automatic subject
selection settings (Number of initial subjects and Subject selection rate after initial subjects).

Excluded subjects are removed from the SV Eligible Pool, which means they aren't considered
in the automatic subject selection settings, and are not SV required unless you manually select
them for source verification. You can, however, mark an item associated with an excluded
subject as critical.

Excluded subjects:
e Are not restricted in any other way from participating in the study events, visits, and so on.
«  Still require their critical forms to be source verified.

* Are still available to be selected as subjects for critical items.

Do my Partial SV settings automatically recalculate?

ORACLE

Yes. Certain changes to the Partial SV pools can cause the auto-select settings (SV Target
Rate or Number of initial subjects) or criticality settings to recalculate. For example, if your
target rate is 5%, Oracle InForm determines how many subjects are equal to 5% of the SV
eligible subjects at the site. If you import 100 subjects to the SV Eligible Pool, Oracle InForm
needs to recalculate to determine how many subjects are equal to 5% of the new number of
SV eligible subjects. This recalculation happens automatically, when you move the subjects.

The following changes to Partial SV configuration settings trigger a recalculation of Partial SV
settings:

* You move a subject from the SV Eligible Pool to the Manual Pool.

* You move a subject from the SV Eligible Pool to the Excluded Subjects Pool.
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* You move a subject from the Manual Pool to the SV Eligible Pool.
* You move a subject from the Auto-Select Pool to the Manual Pool.
*  You move a subject from the Auto-Select Pool to the Excluded Subjects Pool.

* You move a subject from the Excluded Subijects list to the Manual Pool.

The following study changes trigger a recalculation of Partial SV settings:

e Subjects are transferred to or from your site.

e Subjects are withdrawn from the study.

 Anew form is added to the study, or an existing form is removed from the study.

 Anitem is added to or removed from a form.

When | transfer a subject, is the subject assigned to the same Partial SV
Pool at the new site?

It depends. Subjects in the Excluded Subjects Pool remain in the Excluded Subjects Pool at
their new site. All other subjects are added to the Manual Pool. After the transfer is complete,
Oracle InForm recalculates the Partial SV settings at the original site if subjects from the SV

Eligible, Manual, or Auto-Select Pools were transferred.

What is a critical form, and why would | mark a form as critical?

A critical form is a form that you want to be source verified for all subjects at a site, including
subjects who aren't members of the SV Pool. When you mark a form as critical, all of the items
on the form must be source verified.

You might mark forms such as AE and ConMed forms as critical because you want to make
sure that all adverse events and concomitant medications are properly documented for
regulatory agencies.

# Note:

Forms can be automatically marked Verified if they have no items to be verified.
Those forms aren't included in the set of forms you can select using Partial SV.

What is a critical item and why would | mark an item as critical?

ORACLE

A critical item is an item that you want to require source verification for, and that is designated
as SV Required and critical during study design in Oracle Central Designer or by using the
Partial SV settings in Oracle InForm to override the Oracle Central Designer setting. Using the
Partial SV configuration settings, you can override the study design settings to mark an item as
critical for all forms or a subset or forms, and all subjects or a subset of subjects.

Because an item is already considered critical if it's on a critical form, or is associated with a
subject whose data is required to be source verified, you only need to explicitly mark an item
as critical if it wouldn't otherwise be source verified.

You might mark an item as critical if it's only used on a form that is not critical, and is used by
an excluded subject, which means that it would not be source verified unless you made it
critical.
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Can | mark an item in an itemset as critical?

No. If you want to require source verification of an item in an itemset, you need to mark the
entire itemset as critical, and source verify all of the items in the itemset.

What if the item | want to mark critical isn't listed in the Set SV Settings
dialog box?

The Set SV Settings dialog box only lists items that are marked SV Required. To mark an item
as critical, you first have to set it to SV Required using Oracle Central Designer.

How can | tell if an item is critical?

The Effective SV state on the Set SV settings dialog box is Critical for items marked as critical
for one or more forms.

| marked an item as critical for all forms, but | want to change it so that it's
only critical for a subset of forms. Can | do that?

Yes. When you make the change, the item becomes critical for the subset of forms that you
selected, and the study default setting is applied to all other forms.

Why do | see more items in the Set SV Settings dialog box than on the
actual forms?

Partial SV is configured per site, and the Set SV Settings dialog box lists items from every
study version the site has ever been on.

Data Viewer FAQs

In this section

*  What are the Data Viewer views, and what can | do in them?

* What reports are available in the Data Viewer?

*  What tasks can | perform in the Data Viewer?

e | can create queries on some items, but not on others. Why?

* Why do the state counts for my study seem higher than | expected?
*  What does the Updated Since Date filter do?

*  What are custom views and why would | use them?

*  How much data can | include in a custom view?

*  What happens when | add an itemset to a custom view?

*  What happens when | add a repeating form to a custom view?

e Can | create a custom view with forms from different repeating visits?

e Can I change the state of a form from a custom view?
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How can | see the audit history for an item in a custom view?
What are custom review states, and why would | use them?
Is there an audit trail for custom review states?

Custom review states aren't set up for my study, but | want to use them. What should | do?

What are the Data Viewer views, and what can | do in them?

The purpose of the Data Viewer is to allow you to view your study data at a high level so that
you can identify patterns and anomalies, and to ensure that data is completed and cleaned.

The Data Viewer is organized into views, and you can see different data in each view. You can
perform most tasks in the Summary views, the Record Listing view, or the Record Comparison
view. In the Comments view, you only review comments.

Summary view—Review data count summarized across multiple form types. You can filter
the page to see data grouped by visits (default), sites, or subjects.

Record Listing view—Review data for one form across sites, subjects, and visits. You can
also create a custom view so that you can review data from multiple clinical forms on one

page.
Record Comparison view—Compare two Record Listing views side-by-side.

Comments view—Review form and item comments for all sites, visits, and forms.

What reports are available in the Data Viewer?

Different reports are available depending on which summary view you select, and a Subject
States filter is available to give you more control over what data is shown in any of the views.

Comments—Available in all Summary views. Shows the comments logged for each site,
subject, and visit.

Subjects—Available in all Summary views. Shows details for each subject on the selected
form.

Query Aging—Auvailable only in the Summary By Sites view. Shows an overview of query
counts; for example, the number of days that the queries have been in an opened state.

Query Cycle Times—Available only in the Summary By Sites view. Shows the minimum,
maximum, and median number of days it takes queries to move through various query
states.

What tasks can | perform in the Data Viewer?

ORACLE

Review study data.

Create queries on one or more items.

Freeze or unfreeze one or more forms or items.

Lock or unlock one or more forms or items.

Mark one or more forms or items verified or not verified.

Assign up to five custom review states, if they were defined for your study in Oracle
Central Designer.
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| can create queries on some items, but not on others. Why?

You cannot create a query on a calculated item. If you select only one cell, and that cell is for a
calculated item, the Create Query icon does not appear. However, if you select more than one
cell and some of the selected cells are not calculated items, the Create Query icon does
appear. When you submit the data to create the query, a progress indication appears, and any
calculated items are returned as unsuccessful with an error message specifying which records
failed for the action.

Why do the state counts for my study seem higher than | expected?

The Data Viewer summarizes state counts for all users, not just the users whose data you
have access to. For example, if 50 of the 100 forms you have access to are frozen, you might
expect to see that value in the Data Viewer. However, if there are 50 additional frozen forms in
the study that you don't have access to, the value that appears in the Data Viewer is 100, not
50.

What does the Updated Since Date filter do?

Enter a date and time in the filter so that you only see data for forms that:
* Had clinical data changes since the date you entered.

e Had queries that were opened or answered since the date you entered.

When you click Apply, if data changed for a cell in the table, the cell is highlighted.

< Note:

When you view the audit trail from the Data Viewer, the time for this field appears in
your browser's time zone.

What are custom views and why would | use them?

In the Data Viewer, a custom view allows you to view data from multiple forms in one view.
From a custom view you can create queries, verify items, and export the data to Excel.

Custom views have the same look and feel as clinical forms, but they're available only in the
Data Viewer.

* You can create a custom view using activated clinical forms.
* You can include any displayable column from any available clinical form.
«  Columns from different forms are paired to each other based on site, subject, and visit.

* You can't assign a custom view a form states or a review states because although custom
views contain data from clinical forms, they aren't actually clinical forms themselves.

How much data can | include in a custom view?

For non-repeating forms, you can select:
e Columns from a maximum of five forms.

« A maximum of 15 columns across the five forms.
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For repeating forms or itemsets, there are no form and column restrictions because the custom
view displays them in primary and secondary views in the Record Comparison view.

What happens when | add an itemset to a custom view?

Custom views that contain itemsets (for example, from a Dose form) in addition to one or more
non-repeating forms appear in the Record Comparison view instead of the Record Listing view.

In the Record Comparison view:

e All of the items you select for the custom view from a non-repeating form appear in the top
data view panel.

e The itemsets you select for the custom view appear in the bottom data view panel.

< All the itemsets you select for the custom view are available from the Form name drop-
down list in either data view panel.

What happens when | add a repeating form to a custom view?

Custom views that contain one or more repeating forms (for example, an Adverse Event form)
in addition to one or more non-repeating forms appear in the Record Comparison view instead
of the Record Listing view because there can be multiple instances of the same form for a
particular visit.

In the Record Comparison view:

* All of the columns you select for the custom view from non-repeating forms appear in the
top data view panel.

e The first repeating form you select for the custom view appears in the bottom data view
panel.

* All other repeating forms you select for the custom view are available from the Form name
drop-down list in either data view panel.

Can | create a custom view with forms from different repeating visits?

No. You can only include forms from the same repeating visit (that is, the same visit and same
visit index) in a custom view.

Can | change the state of a form from a custom view?

No. A custom view is a representation of data from multiple clinical forms; it isn't actually a
form. Therefore, you can't make form-level changes like freezing, locking, or assigning a
custom review state from a custom view. You can, however, make changes to items in a
custom view. For example, you can source verify an item on a form.

How can | see the audit history for an item in a custom view?

ORACLE

In the bottom-right corner of a custom view or the Record Listings view, click the arrow button
(™) to expand the Details pane.
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What are custom review states, and why would | use them?

Custom review states and stages are created as part of your study design, and available for
use in the Data Viewer. You can use up to five custom review states to track any type of review
progress.

For example, if you want to track forms that need to be reviewed by an adjudication committee,
you might create a review state called Adjudication Review, with the following stages:

*  No Committee Review Required
e Sent to Committee for Review

e Committee Review Complete

As your forms are reviewed, you move them through the workflow by applying the review
states.

Is there an audit trail for custom review states?

Yes. To see the audit trail, in the bottom-right corner of a custom view or the Record Listings
view, click the arrow button (?) to expand the Details pane.

All custom review states are available for use by the Oracle InForm rule package so that rules
can be designed to set or retrieve the custom review states. In the audit trail, any changes
made by the rule package on the custom review states are marked as user Autoquery.

Custom review states aren't set up for my study, but | want to use them.
What should | do?

Custom review states are part of the study design. If you want to add them to your study, your
study designer needs to create and deploy a new study version.

Subject transfer FAQs

In this section

e Which subjects can be transferred?
e Can | transfer more than one subject at a time?

e Can | transfer a subject with outstanding queries, outstanding required signatures, or forms
that are not source verified?

e Can I check the progress of my subject transfer?
e Why did my subject transfer fail?

e Can I still see subject data if | transfer a subject?

Which subjects can be transferred?

ORACLE

Only subjects who are fully enrolled can be transferred to another site. Subjects who are
screened but not enrolled, or have failed enrollment, can't be transferred.
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Can | transfer more than one subject at a time?

Yes, but to transfer more than one subject at a time, you have to use the Oracle InForm Data
Import utility.

Can | transfer a subject with outstanding queries, outstanding required
signatures, or forms that are not source verified?

Yes.

Can | check the progress of my subject transfer?

When you begin a subject transfer process Oracle InForm takes you to the subject transfer
status page, where you can see the progress of the subjects being transferred in real time.
However, if you navigate out of the status page, or if you log out of Oracle InForm and log in
again, you won't be able to return to the subject transfer status page.

Keep in mind that navigating out of the subject transfer status page or login out of Oracle
InForm will not affect the subject status process, which will still run in the background. You can
later check if the process was successful or not in the Subject transfer audit history.

If you need further assistance knowing the status of a subject transfer, please contact Oracle
Support.

Why did my subject transfer fail?

You may not be able to transfer a subject if:

The study requires the combination of the subject's date of birth and initials to be unique
within each site, and the subject you are transferring has the same combination as another
subject at the destination site. To resolve this issue, an administrator must configure the
study or destination site to allow duplicate combinations of subject date of birth and initials.

The study version for the destination site is lower than the study version at your site. You
can only transfer a subject to a site that uses the same or a greater study version than the
one at the original site.

The workflow rules and global conditions fail. These rules and conditions determine the
forms and visits that are visible in the study. Contact Oracle Support for help determining
the cause.

Can | still see subject data if | transfer a subject?

Yes. For all transferred subjects, you can see:

ORACLE

Subject transfer audit history—Shows audit trail data such as the date and time of the
transfer and the originating and destination site for each subject transfer.

Subject transfer archive—An XML archive of the subject history up to and including the
transfer.

The subject transfer archive is organized in the same order as the forms in the case report
book. The links at the top of the archive navigate to a specific form, and the links within
each form navigate to details about the audit history of items, comments, and signatures.

In forms with repeating data, links lead from the summary view to the details about each
set of repeating data.
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Audit trail FAQs

In this section

What information is available in the audit trail?

Who can see the audit trail?

Can | report on audit trail data?

What information about Partial SV is available in the audit trail?

How does the audit trail date/time conversion work?

What information is available in the audit trail?

Each time you change the value of a data item, an audit trail records the date and time of the
change, your user name, and the reason for the change.

Who can see the audit trail?

You can see the audit trail information for the data you have access to, based on your rights.

Can | report on audit trail data?

In the Reporting and Analysis module, the Historical Oracle InForm Access Report will provide
an audit of Oracle InForm user access to the study within a selected date range. You can also
create a report in Cognos Reporting that shows user status and group membership
information.

Form Item Audit Trail information is available in Reports that can be generated in Oracle CRF
Submit, for more information, see the Oracle CRF Submit User Guide for Sponsors.

What information about Partial SV is available in the audit trail?

The following Partial SV configuration data is tracked in the audit trail.

Table 8-2 Partial SV configuration details

. _________________________________________________________________________________|
Event Audit Data Example audit message

Change SV Target rate User, Site, Old rate, New rate, SV Target rate for Site A is 5 %.

Reason for change

Change First N subjects selected User, Site, Old value, New value, Number of initial subjects is 5 for

Reason for change Site A.

ORACLE
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Table 8-2 (Cont.) Partial SV configuration details

. _________________________________________________________________________________|
Event Audit Data Example audit message

Change in Manual Subject list User, Site, Action (Add/Remove), Subject XYZ added to the manual
Subject, Reason for change subject list for Site A.

Note: Adding users to the Manual
Pool through the file import
process produces audit trail
messages similar to the "Change
in Manual Subject list" example.
The import only references
subjects that were added
successfully. Subjects that fail
import due to an error are not

logged.
Change in Excluded Subject list ~ User, Site, Action (Add/Remove), Subject XYZ added to the
Subject, Reason for change excluded subject list for Site A.
Change in Critical Forms User, Site, Action (Add/Remove), Form 123_1 added to the critical
Form, Reason for change forms list for Site A.
Change in Critical ltems Add critical item, Remove critical Iltem [NAME] on [FORM
item NAME/ALL FORMS] is added to

the critical item list.

Item [NAME] on [FORM
NAME/ALL FORMS] is removed
from the critical item list.

How does the audit trail date/time conversion work?

The time (Date hour:min:sec) at which you enter data into Oracle InForm is stored in the
Oracle InForm database in Coordinated Universal Time (UTC). However, the time that displays
in the Oracle InForm audit trail depends on the time zone you specify for a site. You specify the
time zone for a site through processing of the Site MedML, or by selecting a Time Zone on the
Sites detail page when creating a site through the Oracle InForm Admin interface.

Valid time zone values must match those provided by Microsoft in the registry for your
operating system. In addition to the list of time zone names, Microsoft stores each time zone's
offset from UTC and details on the start and end date/time of daylight saving time where
applicable. InForm uses this information to convert the data entry date/time stamp to the time
zone for the site.

InForm:
1. Reads the audit date/time stamp from the database.
2. Retrieves the site's time zone setting specified in the InForm metadata.

3. Looks up the site time zone in the operating system registry, returns the necessary offset
information, and determines whether the date/time in question is within or outside the
daylight saving time adjustment.

4. Converts the date/time stamp from the database according to the offset information, and
displays the converted information in the audit trail in the user interface.
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Automated deployment FAQs

In this section

e What is automated deployment?

e What should | do before deploying a study?
e What is the deployment log?

What is automated deployment?

Automated deployment is the process of deploying a study to Oracle InForm without
assistance from system administrators. In Oracle InForm, you can only deploy studies if they
do not require approval, and you can only deploy one study package at a time from the Oracle
InForm user interface.

We recommend that you do all of your deployments from Oracle Central Designer.

# Note:

Note: Automated deployments are only supported for single database (SameDB)
installations, where Oracle InForm and the Reporting and Analysis module are
installed in the same database instance.

What should | do before deploying a study?

Before deploying a study, you should:
* Make sure that the deployment package is available on your local machine.

e Stop all activity on the study.
During automated deployment, the study is put into maintenance mode. In maintenance
mode, the Oracle InForm user interface is not available and any rules, Oracle InForm Data
Import utility processes, or Clinical Data API processes that are running against the study
fail because the study denies all processing requests.

What is the deployment log?

The deployment log is a log file containing the details of the deployment. When you deploy a
study, Oracle InForm creates a log file and saves a copy of the deployment package. The
deployment log is available for all deployments that have been scheduled, canceled, or
completed.

* The log file is saved to the INFormDeploy\<study>\Logs folder.
* A copy of the study package is saved to the InFormDeploy\<study>\Archive folder.

Home page FAQS
In this section

e What is the Home page?

e Do | need to use the Home page?
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* Can | delete a tab?

* How many tabs can | create?

e How can | organize the content of the tabs?

*  What document file types can | upload to the tabs?

*  Where can | find a history of the documents | upload?

e Can | restrict access to a document?

What is the Home page?

The Home page is the first page you see when you log in to Oracle InForm. It is created using
the Oracle InForm Portal, which might be installed during the Oracle InForm installation. The
Home page gives you access to information about the study, and is configurable. If the Oracle
InForm Portal is installed for your study, you see the Home page tabs under the Home button
in the upper-left when you log in to Oracle InForm.

Do | need to use the Home page?

No, you do not have to define a Home page. However, if you choose to, you can define one at
any time.

Can | delete a tab?

No, a tab cannot be deleted, but you can activate or deactivate the tab as necessary.

How many tabs can | create?

You can have a maximum of 13 activated tabs, including the Admin tab, for each product
locale.

How can | organize the content of the tabs?

You can organize the contents of a tab using sections. For example, you might group white
papers based on their categories of information. For more information, see Create and modify
sections in a tab on the Home page

What document file types can | upload to the tabs?

e Microsoft Word, PowerPoint, Excel and Project

e Adobe Acrobat Portable Document Format (PDF)
e Hypertext Markup Language (HTML)

e GIF and JPG images.

# Note:

You can't include embedded graphics in HTML documents.
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Where can | find a history of the documents | upload?

The most recent version of a file appears when you open the document, but you can click
Expand Versions to the right of an uploaded document to view all previous versions of the file.

Can | restrict access to a document?

Yes. Put the document on a tab designated for sponsors only.

System alert FAQs

In this section

e What is a system alert?

e | know | have a site with an invalid time zone. Why can't | see the list of open time zone
alerts?

What is a system alert?

A system alert is an icon, which appears in the upper-right corner of the user interface, that
indicates whether time zones for a sponsor's sites are invalid.

|
e The Alerts icon is yellow (") if there are open time zone alerts for a sponsor's sites.

e The Alertsiconis grey () if there are no open time zone alerts for a sponsor's sites,
and for non-sponsor users.

| know | have a site with an invalid time zone. Why can't | see the list of
open time zone alerts?

You might not be able to see the list of open time zone alerts if:
* You aren't associated with any sites.

* You aren't a Sponsor user.

User Acceptance Testing FAQs

In this section

e Can | switch roles during User Acceptance Testing (UAT) environments?

Can | switch roles during User Acceptance Testing (UAT) environments?

While users can only be associated to a single Rights Group and a single user type in live
study environments, a User Acceptance Testing (UAT) environment allows a single user to
switch to any user type and any of the Rights Group associated with a UAT study.
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# Note:

This feature is intended to be used only for test studies that have test data. The intent
of this feature is to allow the user to be able to test the roles (rights group) that they
are or will be assigned to in the live study. For example, if a user is associated to
rights group A, they should test rights group A and not select rights group B.

When switching between user types or Rights Group in a UAT environment, consider that:

e Any Rights Group that includes ODMSubmit is excluded from the list of available Rights
Groups.

« Any Rights Group that has more admin rights than the current user's Rights Group is
excluded from the list of available Rights Groups.

e When comparing which Rights Group has more admin rights, all user admin rights are
considered except View System Configuration, View User Information and Subject
Transfer.

e Switching from one Rights Group to another does not give users new admin rights, but
they may see restrictions if they change to a Rights Group with less admin rights.

e The capabilities of this feature in relation to Oracle InForm Reporting are limited to
providing or revoking access to the Reporting Module, dependent on if the assigned Rights
Group has the right Reports selected or un-selected. The functionality and access
available to a user within Oracle InForm Reporting is controlled by InForm user-specific
Reporting Group selection, which will remain unaltered when the Rights Group of a user is
changed.

e The only ways to change users to a Rights Group with more admin rights are through
MedML, UMT or login with the system admin user.

To change your user type or Rights Group during in a UAT environment:

1. Log into Oracle InForm.

2. Click on the Modify user button (‘8/).

3. Inthe User Type section, select either Site User (default) or Sponsor User

# Note:

Oracle recommends that users do not change the user type from Sponsor User
to Site User or vice versa when working with rights related to the CRF Submit
functionality. The request types that these users can create are dependent on
their user type. In addition, the requests that were created as a Sponsor user
type may have already been shared with Site user types. If the user types are
switched after creating the requests, the created or shared requests may not be
available for Sponsor or Site users as intended.

4. In the Rights Group section, select one of the available Rights Groups from the drop-
down menu.

5. Click Submit at the bottom right of the page.
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6. Click OK in the User information updated pop-up window.

After the Oracle InForm page is reloaded, the new Rights Group associated with the user
appears in parenthesis next to the user name.

To view the history of Rights Group and user type changes for a user in the User Audit History
record:

1. Log into Oracle InForm.

2. Click on the Modify user button (‘U).

3. Inthe User Type section or the Rights Group section, click the User Audit History button
(

=
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